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Privacy Policy 

June 30, 2020 Version 

 

Article 1 - Purpose 

This privacy charter (hereinafter the "Charter") applies to all processing of personal data, implemented by 
Hyperlex and relating to any person from whom data is collected, including Internet users, recruitment 
candidates, customers, partners, suppliers and their respective employees (hereinafter the "User"). 

Hyperlex undertakes to implement adequate measures to ensure the protection, confidentiality and security 
of personal data in accordance with legal requirements and in particular the French law n°78-17 of January 
6, 1978 as amended (the "Data Protection Act") - and any law or regulation that would supplement or 
replace it - and the European Regulation 2016/679 on the protection of personal data ("RGPD"). 

The purpose of the present Charter is to inform the User about the commitments made by Hyperlex in order 
to ensure the respect of personal data (as defined in article 4 of the RGPD, hereinafter the "Personal 
Data"). 

Article 2 - Personal data collected 

Hyperlex ensures that it collects and processes Personal Data that is relevant, adequate, non-excessive 
and strictly necessary to achieve the purposes that have been previously determined. Hyperlex takes all 
necessary steps to ensure that the Personal Data is accurate, complete and, if necessary, updated. 

Hyperlex processes the Personal Data that the User is likely to communicate to it, in particular during the 
following operations: 

• when subscribing to Hyperlex services; 

• when using Hyperlex services; 

• when browsing the Site; 

• when the User applies for a job offer on the Site ; 

• when sending newsletters and other commercial information from Hyperlex in compliance with the - - 
applicable regulations; 

• when using the contact form available on the Site. 

The User must provide the Data required during the registration procedure in the mandatory fields of the 
questionnaire marked with an asterisk to benefit from the Services (*). 

In the absence of an answer, the User's registration on Hyperlex and for the Services offered cannot be 
completed and the User will not be able to benefit from all the Services offered on Hyperlex. 

User responses in fields not marked with an asterisk (*) are optional. 

Within this framework, Hyperlex collects and processes the User's Personal Data, such as in particular : 

• data relating to the identity of the User (such as, in particular, his surname, first name, postal address, 
telephone number, email address, login and password); 
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• the User's payment and/or banking information (such as, in particular, bank account and billing data for 
services provided by Hyperlex and its partners); 

• the computer data of connection and browsing on the Site (such as, in particular, the date, time of connection 
and/or browsing, type of browser, browser language, IP address); 

• any other Personal Data made available to Hyperlex by the User. 

Article 3 - Purposes of treatment 

The Personal Data collected are processed by Hyperlex for the following purposes: 

• management of access to and use of the services (management of the subscription request, the account, the 
commercial relationship). In this context, the legal basis of the processing is the execution of the contract 
between Hyperlex and the User; 

• the receipt of personalised offers and/or newsletters from Hyperlex, which may relate in particular to new 
functionalities or service updates. In this context, the treatments are based on Hyperlex's legitimate interest, 
more specifically its economic interest in proposing to the User personalised offers, to better understand his 
needs and to offer him adapted services; 

• billing for the paid features of Hyperlex's services. In this context, the legal basis of the processing is the 
execution of the contract between Hyperlex and the User; 

• management of the commercial relationship with Hyperlex's service providers and partners (management of 
the contract, orders, deliveries, invoices, etc.). In this context, the legal basis of the processing is the 
execution of the contract between Hyperlex and the User; 

• analysing navigation on the Site and improving its use (see article 5 below on cookies). In this context, the 
legal basis of the processing is the legitimate interest of Hyperlex, more specifically its economic interest in 
constantly improving its Website and its services and in understanding the needs of Users in order to meet 
their expectations; 

• to respond to questions, complaints and requests for information from Users. In this context, the legal basis of 
the processing is either the execution of the contract if the request is related to the contractual relationship 
between Hyperlex and the User, or the legitimate interest of Hyperlex, more specifically its economic interest 
to communicate clearly with the User and to understand his needs and expectations; 

• to follow the User's application file submitted online on the Site. In this context, the legal basis for the 
processing operations is Hyperlex's legitimate interest, more specifically its interest in responding to requests 
for applications and in finding profiles suited to the posts available within Hyperlex. 

Article 4 - Retention of data 

Personal Data are only kept for a reasonable and strictly necessary period of time to achieve the purposes 
of the processing for which they were collected or which were subsequently authorised by the User 
(Hyperlex may however keep Personal Data for a longer period of time to comply with legal obligations and 
in particular the applicable limitation periods). Beyond this period, they will be kept anonymously for 
exclusively statistical purposes and will not be used in any way. 

In order to define an adequate retention period of Personal Data, Hyperlex uses in particular the following 
criteria : 

• The data relating to subscription, payments and use of the services are kept for the entire duration of the 
subscription / contractual relationship and then in accordance with the applicable limitation periods; 

• The data relating to the management of the commercial relationship with the service providers and partners 
are kept for the entire duration of the contractual relationship and then in accordance with the applicable 
limitation periods; 

• If the User has consented to receive commercial canvassing, Hyperlex shall keep his Personal Data until the 
User expresses his wish to no longer receive communications or after a period of inactivity defined in 
accordance with applicable legislation; 

• The data collected in the context of queries/questions relating to the Hyperlex Site and services are kept for 
the duration necessary to process said queries; 
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• Candidate files are kept for 2 years from the last contact with the candidates, unless the candidates consent 
to a longer storage period; beyond that, the data are archived in accordance with the applicable limitation 
periods; 

• Cookies or other tracers deposited on the User's terminal are kept in compliance with legal obligations and 
recommendations issued by the authorities (i.e. 13 months in France for cookies and tracers that are not 
essential to the operation of the Site). 

Article 5 - Use of cookies 

When browsing the Site / when using the services, cookies may be installed on the User's browser software 
to enable optimal navigation. Cookies are data stored in a user's terminal equipment. 

The information contained in the cookies is kept only for the time strictly necessary for their purpose. 

The cookies used are strictly necessary to Hyperlex since their purpose is to facilitate electronic 
communication between the User and Hyperlex and to allow the provision of Services to the User. 

Their function is, in particular, to : 

• recognize the User when connecting to the Site; 

• measure the Site's audience. 

The prior consent of the user is required before setting up any type of cookies, including web audience 
measurement cookies and social network cookies. When accessing the site's home page for the first time, 
the user is displayed a banner allowing him/her to obtain his/her consent, in accordance with the CNIL's 
recommendation in this regard. The lifetime and validity of cookies cannot exceed 13 months. Beyond this 
period, cookies should not be placed and executed before obtaining the user's consent again. 

The User may oppose the insertion of cookies at any time by configuring the preferences of his browser. 
He can also disable at any time the cookies that have been installed on his computer. The User is informed 
that certain features of the Site or certain services will no longer be accessible if cookies are deactivated. 

To set up your browser to block cookies, the User may consult the CNIL 
website. (https://www.cnil.fr/fr/cookies-les-outils-pour-les-maitriser). 

• (If you wish to configure your browser to disable the installation of cookies, you can follow the instructions 
below: 

• For Mozilla Firefox: select the "Tools" menu, then "Options". Click on the "Privacy" icon, locate the "Cookies" 
menu and select your preferred options. 

• For Microsoft Internet Explorer 6.0 and higher: select the "Tools" menu, then "Internet Options". Click on the 
"Confidentiality" tab and use the slider to select the desired level. 

• For Opera 6.0 and later: in the "File" menu, select "Preferences", then click on "Privacy" and select the 
desired options. 

• For Safari: from the Safari menu, select "Preferences", then click on "Security" and select the desired options. 

• For Google Chrome: Select the Chrome menu, then select "Settings" and click "Advanced Settings. In the 
Privacy section, choose "Content Settings", then in the "Cookies" section, you will be able to select your 
options). 

The website also uses Hubspot and Google analytics to track website performance and help us optimize 
your online business. If you do not want Google analytics to track your activities while you are browsing the 
site, please click on the following link : (https://tools.google.com/dlpage/gaoptout?hl=fr) 

Article 6 - Recipients of the Personal Data collected 

https://www.cnil.fr/fr/cookies-les-outils-pour-les-maitriser
https://tools.google.com/dlpage/gaoptout?hl=fr
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6.1 Sharing Personal Data for Service Purposes 

For the purposes of providing the services, the Personal Data are transmitted to Hyperlex's partners and to 
third party service providers who act as Hyperlex's subcontractors who may carry out the processing or 
other IT services in relation to the services. These service providers act only on the instructions of Hyperlex 
and will only have access to the Personal Data of the Users in order to perform these services and will be 
bound by the same obligations of security and confidentiality as Hyperlex. 

Hyperlex is likely to transfer all or part of its assets, and in particular the activity relating to the services for 
which it processes Personal Data, in the context of a merger, acquisition, reorganisation, total or partial 
sale of its assets or in the event of a receivership or judicial liquidation. The User accepts and is informed 
that Hyperlex's successor may process Personal Data to ensure the continuity of services in accordance 
with the Charter. 

6.2 Sharing of Personal Data for Prospecting Purposes 

Hyperlex may transfer the User's Personal Data to its partners and companies of its group, after having 
obtained the express consent of the User to receive communications and commercial offers relating to 
products and/or services provided by the partners and companies of its group. 

The User may oppose at any time the receipt of these communications and commercial offers from 
partners by informing Hyperlex in accordance with Article 2 of the Charter. 

6.3 Disclosure of Personal Data 

Under special circumstances, Hyperlex may be required to disclose Personal Data: 

• to any competent judicial or administrative authorities which may request its communication in accordance 
with the applicable legislation. 

• to comply with legal obligations, to protect the rights and/or safety of an individual, to protect the rights and 
property of Hyperlex, including the need to see this Charter respected, and to prevent fraud, security or 
technical problems. 

Article 7 – Transfer of Personal Data 

The subsidiaries, service providers or other third parties listed above to whom Hyperlex is likely to 
communicate the User's Personal Data may be domiciled abroad and in particular outside the European 
Economic Area. 

Hyperlex then requires them to take, in accordance with the regulations in force, all organisational and 
technical measures to ensure an adequate level of protection of Personal Data (in particular by the 
implementation of Standard Contractual Clauses approved by the European Commission - a copy of which 
is available on request by the User). 

Article 8 - Security and Confidentiality of Personal Data 

Hyperlex has taken all useful precautions, with regard to the nature of the Personal Data and the risks 
presented by the processing, to preserve the security of the Personal Data and, in particular, to prevent 
them from being distorted, damaged, or that unauthorised third parties have access to them. 
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Personal Data are processed by Hyperlex in order to ensure their security and confidentiality within the 
limits where it is impossible to fully guarantee the security of the Internet and of the data transmitted via the 
Internet. 

Article 9 - User Rights 

In accordance with the applicable legislation on the protection of Personal Data, the User has a certain 
number of rights concerning the collection and processing of his Personal Data, namely : 

• The right to be informed: the User has the right to be informed in a concise, transparent, 
comprehensible and easily accessible manner of the way in which his/her Personal Data is 
processed. 

• The right of access: the User has the right to obtain (i) confirmation as to whether or not Personal 
Data relating to him/her is being processed and, if so, to obtain (ii) access to and a copy of such 
Personal Data. 

• The right of rectification: the User has the right to obtain the rectification of Personal Data 
concerning him/her that are inaccurate. The User also has the right to obtain the completion of 
incomplete Personal Data, including by providing an additional declaration. 

• The right to erasure: In certain cases, the User has the right to obtain the deletion of his Personal 
Data. However, this right is not an absolute right and Hyperlex may have legal or legitimate reasons 
to keep the said Data. 

• The right to limitation of treatment : In certain cases, the User has the right to obtain the limitation of 
the processing of his Personal Data. 

• The right to portability: the User has the right to receive the Personal Data concerning him/her that 
he/she has provided to Hyperlex, in a structured, commonly used and machine-readable format, 
and the User has the right to transmit such Data to another data controller without Hyperlex being 
an obstacle. This right only applies when the processing of Personal Data is based on the consent 
of the User or on the execution of a contract and the said processing is carried out by means of 
automated processes. 

• The right of opposition: the User has the right to oppose at any time, for reasons relating to his 
particular situation, to the processing of Personal Data concerning him when said processing is 
based on Hyperlex's legitimate interest. Hyperlex may, however, have legitimate and compelling 
reasons to continue treatment. When his Personal Data is processed for prospecting purposes, the 
User has the right to oppose at any time to the processing of such Data. The User can notably 
benefit from this right by clicking on the "unsubscribe" link available at the bottom of received 
messages. 

• The right to lodge a complaint with a control authority: the User has the possibility to contact the 
CNIL in order to lodge a complaint concerning the practices relating to the protection of Personal 
Data of Hyperlex. 

• The right to give instructions concerning the use of Personal Data after death: the User has the right 
to give Hyperlex instructions concerning the use of his/her Personal Data after his/her death. 

To exercise these rights, the User may send a request to the following address: dpo@hyperlex.fr or by post 
to Hyperlex, 12 rue Anselme, 93400 Saint-Ouen, France, enclosing a copy of an identity document with the 
request. 

Article 10 – Amendment of the Charter 

Hyperlex may update this Charter at any time to adapt it to any new practices and service offers. In this 
case, the Charter will be updated to show the day on which the changes were made. It is the User's 
responsibility to check for any updates to this Charter posted on the Site. In the event of a substantial 

mailto:dpo@hyperlex.fr


 
 

6 
 

modification, the User will be informed by means of a warning on the Site before the modification is 
implemented. 

Article 11 – Contact 

For any request for information relating to this Charter, please contact contact@hyperlex.fr. 

 

mailto:contact@hyperlex.fr

